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1 Introduction

Acoustica is a comprehensive solution for professional audio recording, editing and

mastering. The intuitive user interface was designed with speed, accuracy and

ease-of-use in mind and gives access to a large set of powerful tools to make your

recordings sound the best.

1.1 Requirements

Before you install Acoustica Basic Edition, please make sure your computer fulfills the

following requirements:

· A Pentium IV or higher, including SSE2 support

· Minimum 256 MB RAM (1 GB recommended)

· A Windows MME or ASIO compatible sound card

· Windows 8, Windows 7, Windows Vista or Windows XP

2 Basic Audio Editing

This chapter describes the basic audio editing capabilities of Acoustica such as loading

and saving files and editing using the clipboard or drag and drop.

2.1 The Acoustica Workspace

The Acoustica workspace can contain several audio editing windows, CD projects or

Cleaning Wizard projects. 
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The Acoustica workspace

The figure above shows the Acoustica workspace with an audio editing window and a

CD project. The elements indicated with the red arrows are explained below:

1. The main toolbar with short cut icons for commonly used commands.

2. The navigation toolbar for recording, playback and cursor positioning.

3. An audio editing window containing the audio file "Matecha.wav". The audio is

visualized with a curve corresponding to the recorded audio.

4. A selected region indicated with white curve on a blue background (colors depend

on your system settings). The current cursor position is indicated by a blinking line.

5. The output level meters show the current output level during audio playback.

6. The status bar indicating the selected region, the viewed region and the cursor

position. During processing, the progress is displayed in the status bar.

7. A "CD project" window containing a list of tracks and a toolbar for commands

relevant to CD recording.

8. The list of CD tracks that are about to be recorded to an audio CD.
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2.2 Loading Audio Files

To open existing audio file,

1. Select from the File menu the command Open...

2. Choose the folder in which your file is located from the Look in drop-down list.

3. Click the audio file you wish to open and click the button labelled Ok.

2.3 Saving Audio Files

To save an edited audio file with its original name:

1. Select from the File menu the command Save or press Ctrl+S.

If you wish to save the content of an audio editing window with a different name, in a

different folder or with different settings:

1. Select from the File menu the command Save as...

2. Choose the folder in which you wish to save the file from the Look in drop-down list.

3. Enter a name for your audio file.

4. Choose the file format of your audio file from the File type drop-down list.

5. Most export filters offer different settings such as encoding bit rate or number

format. To change the settings, click the button labelled Options... .

2.4 Playing a Recording

To play the selected region of a recording:

1. Select from the Sound menu the command Play or press the space bar.

2. You can stop the playback by selecting from the Sound menu the command Stop or

by pressing the space bar.

You can also play the complete recording:

1. Select from the Sound menu the command Play all or hold the shift key while

pressing the space bar.

2. You can stop the playback by selecting from the Sound menu the command Stop or

by pressing the space bar.

To play the selected region as a loop:



6 Acoustica User Guide

Copyright © 2013 Acon AS

1. Select from the Sound menu the command Play looped or hold the control key while

pressing the space bar.

2. You can stop the playback by selecting from the Sound menu the command Stop or

by pressing the space bar.

Alternatively, you can use the navigation toolbar for convenient playback:

The navigation toolbar with the logic similar to consumer audio equipment such as CD players or

tape decks.

2.5 Selecting Regions

Acoustica does all processing on the selected region and the selected channels only. The

selected region is highlighted. To change the selected region:

1. Click the beginning of the region you wish to select and keep the mouse button

down.

2. Move the mouse cursor to the end of the region you wish to select while keeping the

mouse button down.

3. Release the mouse button.

4. The newly selected region should now by highlighted.

2.6 Selecting Channels

Acoustica does all processing only on the selected region and the selected channels. To

change the selected channel or channels (only possible with stereo recordings):

1. Click the channel selection button in the main toolbar (see The Acoustica Workspace

): 

2. A drop-down list with the channels appears.

3. Click the channel you wish to activate or deactivate.

2.7 Zooming and Scrolling

You can zoom in to get a more detailed view in an editing window. You can zoom either

horizontally to view a smaller part of the recording or vertically to show a smaller

amplitude range.

Horizantal zoom

To zoom in horizontally:
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· Press the arrow up key

- or -

· Move the mouse wheel upwards

To zoom out for a better overview:

· Press the arrow down key

- or -

· Move the mouse wheel downwards

Note You can zoom out to view the whole recording by selecting View | View all

or by pressing Shift + A.

Scrolling

In those cases where only a part of the recording is shown, a scroll bar is visible below

the visualisation of the wave form. You can use the scroll bar to view other parts of the

recording.

Vertical zoom

To zoom in vertically:

· Press and hold the control key while pressing the arrow up key

To zoom out vertically:

· Press and hold the control key while pressing the arrow down key

You can also enter the zoom factor in the toolbar and press the enter key:

The vertical zoom bar

2.8 Drag and Drop Editing

You can move or copy regions using so-called drag and drop editing. To move a region

to a another location in the same editing window or to another editing window:

1. Select the region you wish to move (see Selecting Regions).
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2. Click the somewhere within the highlighted region and keep the mouse button

down.

3. Press the Shift key while moving the mouse cursor to the new start position and

release the mouse button.

To insert a copy of a region using drag and drop:

1. Select the region you wish to copy (see Selecting Regions).

2. Click the somewhere within the highlighted region and keep the mouse button

down.

3. Press the Ctrl key while moving the mouse cursor to the insert position and release

the mouse button.

To mix two regions using drag and drop:

1. Select the first of the regions you wish to mix (see Selecting Regions).

2. Click the somewhere within the highlighted region and keep the mouse button

down.

3. Press the Alt key while moving the mouse cursor to the start position and release the

mouse button.

Note If you press neither the Ctrl key nor the Shift key during drag and drop,

Acoustica will perform the default action which is a move operation if the

drop destination is the same editing window and a copy operation if the

drop destination is another editing window.

2.9 Editing using the Clipboard

The clipboard concept provides a common way of editing documents for all Windows

applications. You can edit your recordings by copying the selected region to the

Acoustica clipboard using the command Edit | Copy and paste the region into another

location using the command Edit | Paste Insert. The Paste Insert command is equivalent to

the normal paste command common in most Window applications. Acoustica has offers

two additional ways of pasting:

· Paste Overwrite, which substitutes a selected region with the content of the

clipboard.

· Paste Mix, which mixes the selected region with the content of the clipboard.

The command Edit | Cut copies the selected region to the clipboard before deleting it

from the source recording. For the purpose of deleting parts of the recording, use one of
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the following two commands:

· Delete, which deletes the selected region

· Crop, which deletes everything but the selected region.

2.10 Audio Scrubbing

Sometimes it is hard to find a specific part of a recording using the visualization only.

The audio scrub mode simplifies the search by giving aural feedback while you can

move the playback position using the mouse. To use the audio scrubbing:

1. Enable the audio scrubbing mode clicking the audio scrubbing symbol in the toolbar

(  ) or by pressing A.

2. Click the left mouse button and keep it down while moving the mouse cursor

3. Release the mouse button when you have found the part you were searching for.

4. Enable the selection mode by clicking the selection mode symbol in the toolbar (  )

or by pressing S.

2.11 Labels and Regions

You can simplify the editing process by inserting anchors such as labels and regions to

your recording.

Adding Labels

To add a label to the recording:

1. Move the cursor position to where you want the to insert a label

2. Click the right mouse button and select "Add Label..." or press L.

3. A label appears at the cursor position

Note You can press Ctrl + L to add a new label and directly open a dialog box to

give it a name.

Adding Region Markers

To add a region marker to the recording:

1. Select the part of the recording where you want a region marker

2. Click the right mouse button and select "Add Region..." or press R.

3. A region is appears at the selection
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Note You can press Ctrl + R to add a new label and directly open a dialog box to

give it a name.

Renaming, Moving and Deleting Anchors

You can easily rename anchors:

1. Double click the anchor text

2. A properties dialog box appears.

3. Enter the new name of the anchor.

4. Click the button labelled OK.

You can also move the anchors:

1. Click the left mouse button at the upper part of red line visualizing the anchor.

2. Keep the mouse button down while moving the anchor to its new position

3. Release the mouse button.

To delete an anchor:

1. Click the right mouse button at the anchor text

2. A context menu appears.

3. Select "Delete"

The Label and Region List Windows

You can edit and keep track of your anchors by showing the region list and label list

windows. To show the label list window, select "Label List" from the View menu. The

menu item "Region List" from the same menu shows the region list.

The Region and Label List windows make it easy to edit and keep track of the anchors.
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2.12 Adding Loops for MIDI Samplers

Audio files in the WAVE format can contain specialized loop information for MIDI

Samplers and software samplers. Acoustica supports this standard and you can add

loops and define the base note and fine tuning of the recorded sample. To add a sample

loop, selected Edit | Add Sampler Loop... or press "O". The Add Sampler Loop dialog box

appears:

The Add Sampler Loop dialog box.

You can specify an infinite loop that is repeated until the MIDI note is released or a

specific loop count. Acoustica also allows you to crossfade the ending and the beginning

of the loop to avoid click sounds at the loop edge. Add a check mark to the Enable

Crossfading check box to enable the cross fading. You can specify the percantage of the

loop duration that is used for cross fading.

The information in Global MIDI Sample Settings is not stored for each loop, but are global

settings for the complete recording. You can edit these settings when adding loop,

because loop and note with fine tuning information is usually required when creating

loops for MIDI samplers. However, you can also change these parameters in the Tempo

and Key tab of the recording properties  (File | Edit Properties...).
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2.13 Using Analyzers

The integrated analyzers allow you to analyze the output audio signal in real time

during playback. You can hide or show the analyzers by choosing View | Analyzers and

selecting one of the analyzers from the sub menu.

2.13.1 Level Meter

The level meter lets you analyze the output level in terms of peak, peak hold and RMS

values. The peak value is the maximum sample within a short analysis interval and is

the value defining the height of the level meter bars. The peak hold value is the

maximum sample level over a longer period of time. It is indicated as a white line above

or at the top of the level meter bar. RMS stands for root-mean-square and is calculated

by the root of the sum of the squared sample values during the analysis interval.

The level meter analyzer showing the peak hold value (1), peak value (2) and RMS value (3).

You can configure the level meter to use different scales or change ballistics by clicking

the left mouse button somewhere in the level meter. The following dialog box appears:
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The settings dialog for the level meters.

Acoustica supports the K-System metering standard proposed by the audio engineer

Bob Katz. The K-System an attempt to standardize leveling practices throughout the

audio industry. Three standards are available, K-20, K-14, and K-12 which are intended

for different listening environments. You can choose to use one of the K-System meters

or use the digital full scale meter as in earlier version of Acoustica.

2.13.2 FFT Analyzer

The FFT Analyzer shows the frequency content of short analysis time frames. FFT stands

for Fast Fourier Transform. FFT is an efficient way of calculating the frequency domain

of a signal.

The FFT Analyzer shows the frequency content of the output audio signal.

2.13.3 Phase Correlation Meter

The phase correlation meter shows the phase relationship between the left and the right

audio channel in a stereo recording and is an important tool when mastering stereo

recordings. If both channels contain exactly the same signal, the phase correlation meter

will show a vertical line. If one channel is exactly the opposite of the other channel, the

phase correlation meter shows a horizontal line. Normal stereo recordings will show a

cloud of dots spread out vertically and horizontally (see the picture below). In a

properly mastered recording, the cloud of dots should not be wider than it is tall.
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The phase correlation meter shows the relationship between the left and the right channel in a

stereo recording.

2.13.4 Big Time Display

The big time display shows the current playback position in a resizable and dockable

window.

3 Connecting Your Stereo Equipment

This chapter describes how to connect your tape deck (cassette tape player) or your

record player to your computer.

3.1 Connecting a Tape Deck (Cassette Tape)

If you have an external tape deck or a compact stereo system, it will probably have so

called "RCA connectors" on the backside labelled Line Out, Tape Out or Tape Rec, as

depicted below:

RCA connectors on a tape deck unit. Connect the sound card to the Line Out connector (1).

The Line Out of the tape deck or stereo system will now need to be connected to the

computer. Integrated sound cards are usually equipped with "mini jack" connectors (also

called 3,5 mm jack).
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The back pane of a computer with an integrated sound card and a line in mini jack connector (1).

Connecting to a Sound Card with Mini Jack Connector

If you computer has mini jack connectors, a connection cable with a mini jack connector

on one end and RCA connectors on the other end is required to connect your tape deck

or stereo system to your computer.

A connection cable with RCA connectors on one end and a mini jack connector on the other.

If you didn't receive such a cable with your sound card or computer, you can purchase

one in normal audio or electronics stores.

To connect your tape deck or stereo system, connect the end with the RCA connectors to

the Line Out, Tape Out or Tape Rec connectors on your tape deck or stereo system.

Connect the other end to the Line In connector of your computer. The Line In connector is

either labelled as such or indicated with the following symbol: .

Connecting to a Sound Card or USB Audio Device with RCA connectors

External USB devices for audio input and output are growing in popularity and many of

these have normal Line In RCA connectors.  In rare cases, internal sound cards might

also have RCA connectors.  In these cases, a connection cable with RCA connectors on

both ends is required.
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A connection cable with RCA connectors on both ends.

You can purchase RCA connection cables in normal audio or electronics stores if you

don't have one already. In this case, all you have to do is connect the cable to the Line

Out, Tape Out or Tape Rec connectors on your tape deck or stereo system and the Line In

connectors of the sound card.

3.2 Connecting a Record Player (LP)

If you have a stereo system with an amplifier already set-up, the easiest way to connect a

record player to your computer is to connect the computer to the amplifier's Line Out

connectors (sometimes also labelled Tape Out, Tape Rec or Rec Out).

RCA connectors on an amplifier. Make sure the record player is properly connected to the phono

input (1) and connect the sound card to the Rec Out connector (2).
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3.2.1 Connecting a Record Player through an Amplifier

Before you proceed, please make sure your record player is properly connected to your

amplifier and that you can listen to records on your stereo system.

The Line Out of the amplifier or stereo system will now need to be connected to the

computer. Integrated sound cards are usually equipped with "mini jack" connectors (also

called 3,5 mm jack).

The back pane of a computer with an integrated sound card and a line in mini jack connector (1).

Connecting to a Sound Card with Mini Jack Connector

If you computer has mini jack connectors, a connection cable with a mini jack connector

on one end and RCA connectors on the other end is required to connect your amplifier

or stereo system to your computer.

A connection cable with RCA connectors on one end and a mini jack connector on the other.

If you didn't receive such a cable with your sound card or computer, you can purchase

one in normal audio or electronics stores.
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To connect your amplifier or stereo system, connect the end with the RCA connectors to

the Line Out, Tape Out or Tape Rec connectors on your amplifier. Connect the other end to

the Line In connector of your computer. The Line In connector is either labelled as such

or indicated with the following symbol: .

Connecting to a Sound Card or USB Audio Device with RCA connectors

External USB devices for audio input and output are growing in popularity and many of

these have normal Line In RCA connectors.  In rare cases, internal sound cards might

also have RCA connectors.  In these cases, a connection cable with RCA connectors on

both ends is required.

A connection cable with RCA connectors on both ends.

You can purchase RCA connection cables in normal audio or electronics stores if you

don't have one already. An In this case, all you have to do is connect the cable to the Line

Out, Tape Out or Tape Rec connectors on your amplifier or stereo system and the Line In

connectors of the USB audio device.

3.2.2 Connecting a Record Player Directly

It is usually not possible to connect a record player directly to the computer, because the

audio on LP records is modified for technical reasons so that low frequencies (bass) are

too soft and high frequencies (treble) too loud. Amplifiers with a phono input modify

the signal using an exactly tuned equalizer so that the original signal is restored. It is

also possible to purchase hardware units solely for this purpose. These are usually called

phono preamplifiers.

The good news is that you with Acoustica 4 probably don't need any additional

hardware. Acoustica 4 emulates the equalizer in phono preamplifiers and thus restores

the original audio. You can connect the record player directly to the Line In on your

sound card and enable the Emulate phono preamplifier option in the recording page.
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In most cases, the record player will have "RCA connectors" on the backside labelled 

Phono, as depicted below:

RCA connectors on a record player.

Some record players come with a fixed cable with male RCA connectors:

Cable with male RCA connectors.

The output from your record player will now need to be connected to the computer.

Integrated sound cards are usually equipped with "mini jack" connectors (also called 3,5

mm jack).

The back pane of a computer with an integrated sound card and a line in mini jack connector (1).

Connecting to a Sound Card with Mini Jack Connector

If you computer has mini jack connectors and your record player female RCA

connectors, a connection cable with a mini jack connector on one end and RCA

connectors on the other end is required to connect your record player to your computer.
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A connection cable with RCA connectors on one end and a mini jack connector on the other.

If you didn't receive such a cable with your sound card or computer, you can purchase

one in normal audio or electronics stores.

To connect your record player, connect the end with the RCA connectors to the Phono

Out connectors on your record player. Connect the other end to the Line In connector of

your computer. The Line In connector is either labelled as such or indicated with the

following symbol: .

If you record player has an integrated cable with male RCA connectors you will need an

RCA to mini jack adapter (available in audio or electronic stores), as depicted below:

An RCA to mini jack adapter.

The mini jack end of the adapter can be connected to the Line In connector of the sound

card as already described.

Connecting to a Sound Card or USB Audio Device with RCA connectors

External USB devices for audio input and output are growing in popularity and many of

these have normal Line In RCA connectors.  In rare cases, internal sound cards might
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also have RCA connectors. In these cases, a connection cable with RCA connectors on

both ends is required if the record player doesn't have a cable with male RCA

connectors attached.

A connection cable with RCA connectors on both ends.

You can purchase RCA connection cables in normal audio or electronics stores if you

don't have one already. An In this case, all you have to do is connect the cable to the 

Phono connectors on your record player and the Line In connectors of the USB audio

device.

4 Recording

Recording audio in Acoustica is easy, but there are some terms you should know before

starting you first recording project. The chapter Concepts of Digital Audio theoretically

describes some important issues regarding digital audio. If you are familiar with digital

audio, please proceed to Recording through the Sound Card.

4.1 Concepts of Digital Audio

Before audio can be edited on computers it must be digitized. The output from most

audio equipment such as tape recorders, microphones or record players is analog.

Analog means that the audio signal is represented by an alternating electrical voltage.

The voltage is analog to the air pressure changes in the air during the performance,

hence the term analog signals. The sound card in your computer is needed to convert

the constantly changing electrical voltage to a stream of numbers at fixed rate intervals. 

This process is done in two steps called sampling and quantization.

4.1.1 Sampling

The conversion from a continuously changing measure to a series of measured values at

discrete time instances is called sampling. The rate (or number of measurements per

second) of which the sampling is done, is along with the quantization depth the most
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important quality factor of digital recording equipment. If it is set too low, disturbing

artifacts occur. A CD quality recording is recorded with a sampling rate of 44 100

samples per second. We say that the sampling frequency is 44 100 Hertz (or short Hz).

In fact, all frequencies above half the sampling frequency, which is known as the

Nyquist frequency, are substituted by frequencies below the Nyquist frequency. This

effect is called aliasing. To avoid aliasing a sampling system contains of a low pass filter

which ideally filters out all frequencies above the Nyquist frequency and leaves all

frequencies below unaffected. In the case of the audio CD, the highest frequency that

can theoretically be recorded is 22 050 Hz.

4.1.2 Quantization

After measuring an analog input signal at fixed time intervals we have a stream of

samples. The samples exist in terms of a voltage measured at a certain point in time. The

voltage can usually be one of an infinite number of possible voltages within the legal

voltage range. Computers cannot accurately describe every single one of the infinite

number of possibilities, so it is necessary to divide the voltage range of interest into fixed

sized regions. All voltages within one region are given a certain number during the

quantization process. If we have a large number of regions which implies a larger

number of discrete voltage levels, we can describe a voltage more accurately than with

fewer voltage levels. The audio CD is quantized with 65536 voltage levels, which is the

maximum number of levels possible to archive with a binary number with 16 bits. Thus

we say that the Audio CD has 16 bit resolution. Modern recording studios are frequently

using 24 bit resolution or even higher during the mastering process.

The digital representation of a sine wave.

4.1.3 The Decibel Unit (dB)

When the volume of the recorded sound is changed, the degree of change is usually

expressed in terms of decibels or short dB.  This is a common unit in connection with

audio.  In Acoustica, decibel is used to express the extent of change relative to the

original level.
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Special for the decibel unit is that it is based on a logarithmic scale. Zero dB represents

no change, whereas an increase of six dB represents a doubling of the signal amplitude. 

Reducing by six dB results in half the signal amplitude.

 

The decibel dB versus intensity change in percent

The decibel scale is chosen to suit the sensitivity curve of the human ear which have the

same logarithmic property.

4.2 Recording through the Sound Card

Please follow the steps below to record audio from audio equipment such as record

players, tape decks or microphones through your sound card:

1. Make sure the audio source is properly connected to the audio input of your

computer. See Connecting Your Stereo Equipment for more information about how

to connect your audio equipment.

2. Create a new an empty recording window by selecting File | New... or position the

cursor where you want to insert recorded audio in an existing recording.

3. Select Sound | Record... or press Ctrl+R.

4. If you are recording to an empty editing window Acoustica needs to know what

sample format you wish to use (see Concepts of Digital Audio for more information).

The following dialog box appears:

 

The sample format dialog box in Acoustica
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Please choose the desired recording format and click the button labelled Ok.

5. The Recording dialog box now opens:

The Recording dialog box

Now make sure that the correct input line is selected in the line in combo box (1).

You can monitor the input level using the level meters (2) and, if needed, adjust the

input level using the input level slider (3). The level meter should never be in the red

area in order to avoid clipping distortions.

6. Click the button labelled Record (4) to start the recording.

7. When you are done recording, click the button labelled Keep (5) to accept the

recording.

4.2.1 Timer Record

The timer record feature allows you to start and stop recording after a certain period of

time or depending on the presence of an input signal. To start timer record, click the

button labelled Timer Record in the recording dialog. The following dialog box appears:
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The Timer Record settings.

You can choose to start the recording immediately (after clicking the Start Timer Record

button), at a certain time and date or when an input signal is present. The threshold

value for the input signal detection can be defined using the Silence Threshold field at the

bottom of the dialog.

The recording can also be stopped automatically, either after a certain period of silence

or after a certain period of time.

4.2.2 Advanced Recording Options

The recording dialog in Acoustica also offers some advanced settings:

The advanced recording options in the recording dialog

· Remove DC Offset

A DC offset (Direct Current offset) is present in the input signal when the audio

signal isn't centered around the zero voltage line as it should be. The problem is
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quite common on low-end sound cards. DC offset are unwanted and harmful to the

stereo equipment and it can lead to problems when processing the recording further.

You can automatically remove the DC offset by enabling the option Remove DC Offset

. Extremely low and inaudible frequency components (including the DC offset) are

then filtered out of the signal.

· Emulate phono preamplifier

This option should only be enabled when recording from a record player that is

connected directly to the input of the sound card without a phono preamplifier.

· Listen to input (digital monitoring)

You can listen to the signal being recorded (after DC offset and phono preamplifier

processing, if enabled) by enabling this option. It is not recommended to leave this

option on during the complete recording session, because it makes recording glitches

more probable.

5 Audio Processing

In Acoustica, all the processing tools have some properties in common. The processing is

performed on the selected region and the selected channels only. Furthermore, most

tools offer a preset manager that allows you to save often used parameter settings for

later use.

 

The Preset Manager found in most of the processing tools in Acoustica

To add a preset:

· Click the button labelled More...

· A drop down menu appears. Select Add Preset... from the menu.

· In the pop-up dialog, enter the name of the preset and click the button labelled OK.

Loading a preset is equally simple. Just select the preset from the drop-down list and the

preset settings are loaded. User presets can be removed by clicking the button labelled 

More..., selecting Remove Preset... and selecting the preset you wish to remove.

You can bypass the effect processing by checking the check box labelled Bypass transform

for a convenient A / B comparison.

The processing tools introduce some custom controls that you should get familiar with.

The level slider is similar to the Windows track bar, but with some enhancements. The

value range and the current value is always displayed. You can manually edit the value
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by pressing the space bar when the control is active or by clicking the value text below

the level slider. An edit box pops up containing the current value. To change the value,

enter a new value and press return. By pressing the Esc key the changes are discarded.

Examples of knobs (1) and level sliders (2).

The knob control is similar to the level slider, but it is round and is often used to save

space in complex layouts. As with the level sliders, you can change the value by pressing

the space bar or by clicking the value text below the knob.

A more complex custom control is the curve control which is used when a curve input is

needed. The curve control allows the user to add, move or remove points. Straight lines

between the points build the curve. You can add points by clicking the location where

you want a new point to appear in the curve control. You can remove points by clicking

the right mouse button over an existing point.

Examples of a curve edit control.
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5.1 Manipulating Volume

The Volume menu contains several commands for manipulation the volume of a

recording.

· Adjusting the Volume

· Normalize

· Applying a Volume Curve

· Fading In or Out

5.1.1 Adjusting the Volume

The most basic volume manipulation command is the Adjust Volume... command in the

Volume menu. The only parameter is the volume change in decibel. For more

information on the decibel unit,  see The Decibel Unit (dB).

The Adjust Volume settings

5.1.2 Normalize

The Normalize... command in the Volume menu can be used to ensure a constants signal

level in all your audio recordings. You can choose to normalize either the peak or the

RMS level. After selecting your desired maximum peak or RMS output level in decibel,

Acoustica analyses the selected region for the loudest peak or the overall RMS level. The

volume of the region is changed according to the selected level. If you set the normalize

level to 0 dB and use peak level normalization, the loudest part will be the maximum

level reproducible without signal distortion. For more information on the decibel unit,

see The Decibel Unit (dB).
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The Normalize dialog box

5.1.3 Applying a Volume Curve

You can apply a user drawn volume curve on the selected region by selecting Draw

Freehand Volume Curve... from the Volume menu.

The Volume Curve settings

5.1.4 Fading In or Out

If you wish to create fade ins or fade outs, select Fades... from the Volume menu. You can

select a fade curve from one of four mathematical functions from the Fade function

drop-down list:

· Linear

· Logarithmic

· Exponential
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· Sinusoidal

Select the direction of the fade using the Fade in or Fade out radio buttons. The resulting

fade curve is visualized in the curve control.

The Volume Fade settings

5.2 Audio Effects

5.2.1 Echo

The echo effect adds delays or echoes to the selected region. 

The Echo settings

Settings
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· Echo time

· Feedback

The feedback percentage specifies the volume attenuation since the last delay

interval.

· Dry Level

The amount of unprocessed signal in the output mix.

· Delay Level

The amount of processed signal in the output mix.

5.2.2 Convolution Reverb

The convolution reverb can be used to apply recorded impulse responses from real

acoustic spaces. The impulse response file can be of any format supported by Acoustica.

Click the button Load impulse response to load an impulse response file. After loading an

impulse response file, the signal level in dB over time is displayed in the curve edit

control.

The settings page of the Convolution reverb

Settings

· Dry level slider

The amount of unprocessed signal in the output mix.

· Reverb level slider
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The amount of dense reverberation in the output mix.

· Volume curve

You can modify the fade out characteristics of the reverb using the curve edit

control.

5.2.3 Reverse

The reverse effect processes the selected region in such a manner that it will be played

backwards.

5.3 Using Audio Plug-Ins

Acoustica 4 supports DirectX as well as VST plug-ins. Both formats have become widely

used standards for audio processing plug-ins on the Windows platform. The menu 

Plug-Ins contains a list of the plug-ins currently installed on your computer. If you have

installed a plug-in that does not appear in the list, please refresh the plug in list (see 

Refreshing the Plug-in List). Using DirectX or VST plug-ins is as easy as using the

internal audio processing tools.  You will see that previewing works exactly the same

way as with the internal audio processing tools.

5.3.1 Refreshing the Plug-in List

If you have installed new DirectX or VST plug-ins on your computer that do not appear

in the Plug-Ins menu you should refresh the menu by selecting Plug-Ins | Refresh Plug-In

List. Acoustica then rescans the plug-ins on your computer and updates the menu.

5.3.2 Specifying VST Directories

VST plug-ins are not registered on your computer like DirectX plug-in, hence Acoustica

needs to know where to find them. You can specify one or more directories to scan

through.
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The VST Directories dialog lets you specify one or more VST directories to scan through.

To add a new entry, click the add directory button [  ]. You can edit a directory entry

by double clicking with the left mouse button. Delete an entry by clicking the delete

button [  ].

5.4 Converting the Sample Format

You can change the sample format of an audio recording by selecting Sound | Convert

Sample Format... If you are not familiar with the terms sample rate or resolution, please

read Concepts of Digital Audio before proceeding.

To convert the sample format of a recording, select Sound | Convert Sample Format... A

dialog box appears where you can define the sample rate, resolution and the number of

channels in the new sample format. Click the button labelled Ok when you are done.
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The Convert Sample Format dialog box

5.5 Effect Chains

The effect chain editor allows you to link effects, processing tools, VST and DirectX

plug-ins. The chains can be saved including the settings of the effects for later use.

Furthermore, each element can easily be bypassed and the order of the elements

changed using drag and drop.

The effect chain editor in Acoustica.

Adding Effects to the Chain

To add a new effect to the chain, click the add effect button [ ]. A browser window

appears where you can select the effect, plug-in or processing tool you want to add to

the chain.

Removing Effects from the Chain

To remove an effect, select the effect you wish to remove and click the remove button [ 

 ].

Editing the Effect Settings of an Element in the Chain

To open the effect settings window of an element in the chain, double click its entry in
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the list.

Playing the Audio Processed by the Effect Chain

You can play audio processed by the effect chain if you have an open editing window.

Select the region you want to play in the editing window and click the play button [  ].

The selection will be played looped. You can stop the playback by clicking the stop

button [  ].

Bypassing an Element

You can bypass an element by clicking the checkmark left to the effect entry in the list.

Saving and Loading Effect Chains

You can store a complete effect chain including all parameter settings for later use. To

store the effect chain, click the save button [  ]. A standard file save dialog box appears

where you can enter the file name. To open an effect, click the load chain button [  ]

and select the file in the file browser.

6 Preferences and Device Settings

6.1 Device Settings

Window's multimedia system allows several different audio cards being installed at the

same time. You can select which sound card to use by selecting Device Settings... from

the Options menu. Choose input and output devices from the drop-down lists in the

device settings dialog to change the current configuration and click the button labelled 

Ok.

6.2 Changing the Preferences

You can set your personal preferences with the command Preferences... in the Options

menu.
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The Preferences dialog box

The preferences are organized in different pages. Only one page is shown at a time and

you can show another page by clicking the tabs in the upper part of the dialog box. The

following pages are available:

· Directories

· Spectrogram

· Wavelet Transform

6.2.1 The Directories Page

The Directories page contains only one setting, the directory for all temporary files

created by Acoustica. You should set this directory path to a directory on a fast hard disk

with sufficient free space. Acoustica works extensively with temporary files and the

speed of the programs depends to a large degree on the speed of the hard disk where

the temporary files are situated.

The directories preferences page
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